Cultural Competency
Just Good Healthcare

CONTENTS

Introduction
About This Program
Training Materials
Preparation
Presentation Tips

Training Session Overview
Giving the Quiz
Presentation Outline

Program Outline

Quiz

Answer Key

Training Points and PowerPoint® Overview

Customizing a PowerPoint® Presentation
INTRODUCTION

This leader’s guide is designed to permit you to use the accompanying training program in several different ways. Along with the DVD program, you’ll find Training Points and a PowerPoint® slide presentation. These slides can assist you in the presentation of the material and tailoring the training to your facility’s needs. Illustrated employee handbooks are also available for use with this program. They may be distributed to participants as a helpful note-taking tool and for future reference. Contact Coastal if you would like to review or order handbooks.

This program is designed for a wide range of applications and work environments. As an instructor, it is recommended that you tailor the program to your facility’s needs by incorporating specific information unique to your situation and relevant to your participants and location. This leader’s guide is separated into sections on preparing and presenting the session. Exactly how you choose to teach the class is up to you. If you are a new instructor, it is recommended that you follow the program as indicated in this guide.

About This Program

*Cultural Competency: Just Good Healthcare* is designed to inform healthcare workers about the basics of cultural competency. The program focuses on patient-centered care as cultural competency and the importance of respecting patient’s cultural and religious preferences. The program covers how to avoid cross-cultural conflicts and stereotyping and personal biases that can interfere with quality care. Finally, a simple cultural assessment is included to help caregivers learn about patient’s cultural and religious preferences and include them in the patient care plan.

The program is XX minutes long and can be viewed straight through by selecting Play Program from the DVD main menu. To view the program in chapters, which permits discussion during viewing, select Program Outline. Recommended discussion points and demonstration areas are identified throughout the Program Outline section of this leader’s guide.

Training Materials

You will need the following in order to best present an effective training session:

- The training *Cultural Competency: Just Good Healthcare*
- An employee handbook for each participant
- Training room located where there are few distractions
- Television with DVD player or computer with DVD-ROM drive
- Laptop or other computer to project the PowerPoint® presentation. A screen or blank wall is necessary for adequate viewing.
- The PowerPoint® presentation
- Notepads and pencils
- Chalkboard, flipchart or dry-erase board with appropriate markers.
Preparation
Prior to the session, you should do the following:

- **Determine your audience.** Are they new hires or experienced employees? It is recommended that you restrict your audience to each type of employee separately. If that is impossible, make a special effort to keep all employees involved throughout the training session.

- **Schedule the equipment.** Work closely with the person who will be arranging the room, equipment, supplies and participants.

- **Schedule the time for the course.** Participant retention will be greatest in the mornings or the beginning of the shift.

- **Preview the DVD, handouts and Program Outline.** Decide how you will show the program. Will it be viewed straight through or will you stop for discussion? The Program Outline section of this leader’s guide indicates the chapters.

- **Familiarize yourself with the TV and DVD player/DVD-ROM** so you can avoid having to fumble with the controls.

- **Decide how you will use the PowerPoint® presentation** – you may refer to it at stopping points or go through it all at once at the end for review purposes. You may wish to customize it and use it as stand-alone training.

- **Determine facility policy on testing employees.** A quiz is provided at the back of this leader’s guide, but you may want to consult your facility’s rules prior to using it.

- **Rehearse your presentation.** Practice using the training aids and conducting any demonstrations. Make notes and write down any additional points you plan to discuss.
Presentation Tips

Overcoming anxiety

The best way to overcome anxiety about speaking before a group is to be prepared. Although it is natural to feel nervous, your sweaty palms will disappear once you’re focused on what you’re saying – especially if you have a well-prepared plan.

As a training professional, you’re certainly concerned about the welfare of your participants. Focus on what you want people to understand and your presentation will evolve naturally. Remember, trainers and participants are on the same side. By staying focused, you’ll forget you were nervous in the first place!

Choosing your vocabulary

Don’t lose your audience by using sophisticated words they may not understand. Instead, use the same words you would use if you were speaking to each person individually.

Getting rid of the “umms”

One of the most common mistakes a speaker makes is saying “umm” when thinking about the next point to be covered. Be confident and know the subject you are presenting. Don’t be afraid to use silence while you think about what you are going to say next. The silence is really not that long, and you’ll gain credibility because the audience will see you are in control and concerned that the information presented is correct.

Controlling the speed and tone of your voice

You will put your audience to sleep if you speak too slowly, but they won’t be able to keep up with the content if you speak too quickly. Speak to your audience as if you are having a conversation with each one individually. About 150 words per minute is the best speed.

Avoid a monotone voice. Vary your voice’s pitch, volume and tone often – especially when making a particular point. Adding emotion to your presentation will keep your audience attentive and help them to learn better.

Sticking to the schedule

Begin class on time and restart the session promptly at the end of each break. Explain that except for emergencies, messages will be taken for participants during the session and will be distributed at the start of each break.

Asking for questions

There is no better way for a trainer to gauge how well his audience is learning than by listening to their questions. Ask for and encourage questions throughout the session. Be prepared to answer all types of questions, but don’t be worried if you don’t know the answer. Simply say, “I’m not sure of the answer, but I’ll find out and get back to you.” Then, after class, make sure you do find the answer to the question and give it to the person.
TRAINING SESSION OVERVIEW

Giving the Quiz
Prior to the session, perhaps even a few days beforehand, pass out the Quiz for employees to complete. This will give you an idea of how much they already know about Cultural Competency. Administering the Quiz early will help you tailor the training session and show you areas that should be emphasized. If you decide to administer the Quiz at the beginning of the training session, read over the responses while participants watch the program.

At the end of the session, have them again complete the Quiz. Compare the results to the previous quiz immediately and report on any conclusions you make. You may want to meet later with each person individually to discuss his or her particular results.

Presentation Outline

Introduce yourself and the session. Begin with a brief explanation of how the session will be beneficial to both the participants and the facility.

Use an “icebreaker.” True stories relevant to the topic will help relax the group.

Explain the desired outcome of the session. When the participants complete this session, they should:

- Define cultural competency.
- Define patient-centered care.
- Understand how cross-cultural conflicts occur.
- Know how to avoid stereotyping.
- Define biases.
- Understand how to conduct a cultural assessment.

Overview the session. Explain to the group:

- Why the session is being conducted
- When questions may be asked
- How the program will be viewed – either straight through or in segments to allow for discussion
- What to expect
- Where they will be able to use this information specific to your facility.

Introduce the program. Point out what the participants should look for. If portions of the program are inappropriate for your audience, be sure to inform them.

Make sure everyone can hear and see adequately.
PROGRAM OUTLINE

Introduction
This section introduces Cultural Competency: Just Good Healthcare.

Key Points:
- Ethnic minorities make up 33 percent of the US population. By 2050, they’ll be the majority.
- These communities receive lower-quality healthcare, suffer worse health outcomes, and have higher rates of illness, errors and premature death.
- They’re depending on us and we let them down when we think our way – our way of providing healthcare – is the only way.
- How do we give them the quality care they deserve? We give them patient-centered care.
- Healthcare providers who are sensitive to the cultural and religious beliefs of the communities we serve – particularly around health and illness – provide patient centered care.
- This is cultural competency – and it’s a regulation in hospitals across the country.

Discussion Topics:
- Discuss the most common ethnic populations in your community.
- Discuss how language or cultural values can interfere with patient care.

Awareness: How Do Cross-Cultural Conflicts Happen?
This section introduces cross-cultural conflicts.

Key Points:
- Cultural competence is medicine at its best: patient-centered care.
- Our relationship with the person, the human being, is our primary focus and their values and beliefs guide our treatment plans.
- No matter what a patient’s cultural background, we’re all people and people want to be respected and heard.
- We want to have some say in medical decisions that affect us personally.
- When patients don’t understand or agree with what we’re prescribing or ordering – and fail to tell us – patient care suffers.
- If patients prefer alternative healing methods – folk medications, herbs, even shamans or witch doctors – they may not follow treatment protocol, and fail to tell us.
- If patients know we respect them as people, they’re more likely to trust us, to follow through with prescribed therapies and treatments.
- Also, they’re more likely to tell us what they need when they need it.

Discussion Topics:
- Discuss specific examples of ethnic patients who refused to follow the treatment plan because of cultural or religious preferences.
- Discuss specific “culture tools” – e-learning or community resources – that are available to help caregivers learn about cultural preferences among specific ethnic groups.
Self-awareness: How Do We Avoid Stereotyping?

This section introduces stereotyping.

**Key Points:**

- Are you aware of your own cultural beliefs and expectations?
- This awareness is important as a reference to help you understand how cultural values affect our thinking, the way we communicate and how that affects our behavior.
- To find out about your cultural beliefs and expectations, ask yourself the following questions.
- When you’re sick and vulnerable, what kinds of treatment do you expect? What do you need to get well?
- Do you expect your caregivers to include you as part of the healthcare team?
- Do you expect their care to be patient centered – to look to you for critical information?
- What about your family? Do you want them involved in your care, or do you prefer privacy?
- When a loved one dies, what religious practices help you let go?
- In patient-centered care, all of these issues are taken into consideration.
- When we aren’t aware of our own cultural norms, it’s easy to assume all patients think and act the same way we do.
- When you’re critical of another person’s values or beliefs, when you think your way is best, these are your personal biases – prejudices.
- All humans have biases – it’s the way we categorize information quickly. We make assumptions based on personal values, beliefs and experiences.
- In fact, most cultural groups regard their own culture as the best, the most moral and most correct way of living.
- The goal is to train yourself to notice your biases and prejudice, notice how your judgments can lead to communication breakdowns.
- Start by paying attention to your self-talk – that little voice in your head that goes on all the time – except when you’re sleeping.
- When you first meet your patient, what’s your first reaction?
- Do you like him or her instantly – feel an immediate rapport – or do you make snap decisions about what the patient needs or wants?
- When you catch yourself thinking thoughts that could jeopardize patient-provider communication, stop!
- Observe your personal reactions to what may seem a new or unfamiliar cultural practice to YOU.
- Avoid the natural tendency to think your way is best.
- Focus on the person, the individual – that’s patient-centered care.
- Ask yourself how you’d feel if the tables were turned – if you were the patient and he or she was the caregiver.

**Discussion Topics:**

- Describe a specific example of your own personal self-talk while dealing with new patients.
- Discuss specific examples of how your personal biases could jeopardize patient care.
Gathering Information: How Do You Conduct a Culture Assessment?

This section introduces the cultural assessment.

Key Points:

- When you walk into the patient’s room, your goal is to connect with the person and build a relationship of trust by demonstrating that you care.
- You want the patient to be part of the healthcare team.
- After all, these are people, just like you and me, regardless of our obvious differences.
- Don’t forget what you know – what you’ve been doing all along – the basics of a thorough patient assessment.
- The best way to understand the patient’s point of view is to ask questions, explore the patient’s background.
- Ask about the patient’s proficiency with English and country of origin.
- If the patient needs information in a language other than English, make sure interpreter services are available before you begin.
- Let each patient know you’re interested in their cultural and religious beliefs.
- Notice how your patient’s thoughts about disease, their body language and their communication style reflect their cultural roots.
- Patient Assessment tools incorporated into a 10 to 15-minute patient assessment can help you explore central beliefs about health, illness and illness prevention.
- One tool is the mnemonic – E.T.H.N.I.C – to help you remember critical questions.
  - E = Explanation of illness: Ask the patient for an explanation of the illness. Ask for their perspective on what caused the problem?
  - How long do you think it will last?
  - Listen closely for the patient’s perception of the problem.
  - T = Treatment(s) tried or expected: Find out about other treatments they may be using, or treatments tried.
  - Ask about herbal remedies they may be taking, since some herbs can counteract prescription medications.
  - Ask what he or she hopes to receive from this treatment?
  - H = Healers seen: What about traditional healers who’ve been consulted?
  - Keep in mind that while you may believe that disease is caused by bacteria or viruses, some cultures believe disease is a form of punishment, or a loss of soul, or due to curses.
  - Ask questions such as, “Many of my patients from your country believe in alternative treatment. Is this true for you?”
  - N = Negotiate options that are mutually acceptable: Negotiate strategies that meet their needs.
  - The goal is to create a dialogue, a sharing of information.
  - Explain your perception of the problem and the suggested treatment.
  - Acknowledge the similarities and differences between your perceptions.
  - Ask for feedback.
You might ask, “What would interfere with your adherence with treatment recommendations?”

After you get an answer, you might add this: “Now, let me explain why I think it’s important to also consider this type of treatment.”

Ask for feedback.

Ask the patient to repeat what he or she thinks is expected.

Be cautious about explaining a negative prognosis, or possible side-effects or complications.

Some cultures would prefer not to know – even though you may think it’s best to know all possible options.

I = Interventions that may include medications, alternative treatments, and/or psychosocial support: Whenever possible, incorporate cultural folk medications and folk beliefs into the treatment.

C = Collaboration with patient, family members and other traditional healers: Ask about the patient’s family and support group.

Many cultures expect to involve the immediate or extended family in treatment.

For instance, East Indian patients may want to remain with the patient and take over activities of daily living, such as feeding and bathing.

Generally, family members are consulted before decisions are made.

In these cases, respect patient wishes.

Find out about the client populations you serve.

Educational materials, such as “culture tools,” can give you information about belief practices, nutritional preferences, communication issues and common behaviors.

**Discussion Topics:**

- Discuss specific questions you ask ethnic patients to gather information about cultural/religious preferences.
- Explain how a cultural assessment could help ensure patient compliance with treatment protocols.
What Does it Mean to be a Culturally Competent Caregiver?

This section introduces the meaning of culturally competent caregiver.

Key Points:

- Studies show that ethnic patients may prefer to work with same-race caregivers, but more important by far is a caring person – someone easy to talk to, respectful, someone who listens carefully and takes patient concerns seriously.
- Don’t apply the Golden Rule. Apply the “Platinum Rule:” treat others as they want to be treated.
- Learn how others want to be treated.
- We tend to think others want to be treated as we do.
- But what may be considered helpful, polite and friendly care in one culture can be experienced as rude, thoughtless and uniformed in another.
- When in doubt, be honest. Say to the patient, “I want to be respectful of your culture. Can you explain why this is important to you?”
- Let patients know you could make mistakes and ask them to let you know if you violate his cultural beliefs.
- However, important information may still be withheld.
- Different ethnic groups have different rules about displaying respect, and disclosing intimate information to strangers.
- For instance, Middle-Eastern patients may not share information about themselves unless you do the same.
- Asian patients may agree with you to show respect, without having any intention of following through.
- Listen carefully, staying receptive to important clues.
- Use short questions and comments.
- Avoid medical jargon and slang.
- Use basic words and sentences – and repeat basic ideas.
- Speak slowly, not loudly and paraphrase important points.
- Never assume anything. When in doubt, ask questions to discover patient perception of the problem.
- Or ask the patient to explain what he or she needs from you.
- Assess patient coping skills. For instance, what resources does he or she need to follow through?
- Stay alert for body language or “nonverbal cues.
- If you sense the patient has learned as much as she can deal with, stop.
- Offer to provide a list of important regimes to follow, or arrange to talk later.
- If you sense you’ve offended or frightened the patient, apologize and ask for help.
- If the patient seems overwhelmed, ask if it would be helpful to have someone call to remind them when and how to take the medication.
- If the patient speaks limited English, call on a translator – preferably the same gender as the patient.
- Direct questions to the patient. If you suspect the patient is withholding some important information or doesn’t understand, return to the subject and repeat it.
• Be sure the interpreter knows what you want.
• If you’re wondering how we can possibly find the time to learn everything we need to know about different cultures, we can’t – nor do we need to.
• We’re not looking for a cookbook approach to multi-cultural care.
• Stereotyping patients – all Hispanic people do this or that, for instance, or Asian patients don’t tell us the truth – is not the answer.
• Remember cultural competency is patient-centered care – our relationship with the person is primary.
• Everyone – no matter what their country of origin – wants to feel that caregivers are sensitive to our needs, that our personal values and beliefs guide their treatment protocol.
• That’s cultural competence – and it’s just good healthcare.

Discussion Topics:
• Explain what you would say to a patient if you have offended him or her.
• Discuss specific steps to take when you believe the patient is withholding information from you that may be vital to care.
QUIZ

Circle the correct answer.

1. True or False – Ethnic minorities receive lower-quality healthcare.

2. True or False – Patient-centered care and cultural competency are one and the same.

3. True or False – Cultural values affect the way we think.

4. True or False – Your cultural beliefs do not affect your behavior, although they do affect the way you communicate.

5. True or False – Your personal biases are based on your cultural and religious values and beliefs.

6. True or False – Biases are assumptions based on personal values, beliefs and experiences.

7. True or False – Listening to your self-talk is one way to find out if your personal biases are interfering with patient care.

8. True or False – The best way to understand the patient’s point of view is to ask their family members.

9. True or False – When using the tool called ETHNIC, the goal of negotiation is to convince the patient to follow your treatment plan.

10. True or False – It is important to let patients know that culturally-based folk medicines will not help the patient heal.
ANSWER KEY

1. True.
2. True.
3. True.
4. False. Your cultural values and beliefs affect your communication, your body language, your behavior and help shape your personal biases.
5. True.
6. True.
7. True.
8. False. The best way to understand the patient’s point of view is to ask questions, explore the patient’s background, so you can give that person the quality care he or she deserves.
9. False. The goal is to create a dialogue, a sharing of information. Explain your perception of the problem and the suggested treatment. Acknowledge the similarities and differences between your perceptions.
10. False. Whenever possible, incorporate cultural folk medications and folk beliefs into the treatment.
TRAINING POINTS AND POWERPOINT® OVERVIEW

Title Slide


Slide 1


Slide 2


Slide 3


TRAINING POINTS AND POWERPOINT® OVERVIEW CONTINUED

Slide 4

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

Slide 5

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

Slide 6

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

Slide 7

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________

_____________________________________________________________________
CUSTOMIZING A POWERPOINT® PRESENTATION

The PowerPoint® presentations included on the Coastal DVD and CD products are customizable when used on a computer loaded with Microsoft PowerPoint® software. (Note: In the following instructions, “click” implies a click with your left mouse button. If a “right” click is necessary, it will be so indicated.) Microsoft PowerPoint® has many features. The following steps will help you customize our presentations quickly.

To customize a presentation:

If the “Customizable Version” icon is displayed on the landing screen, click on this option. If this option is not available, click on the PowerPoint® presentation to open it.

Save this presentation to another location, such as your hard drive or a folder on the network. You will make your customizations on the saved version.

To add, copy, hide or remove a slide, or to change the order of the slides in the presentation:

Click on “View” on the menu bar.

Click on “Slide Sorter” from the “View” menu. Or, under the “Normal” view, you may use the “Outline” on the left side of the screen.

To add a slide, place your cursor in front of the slide where you want to add a slide. Click on “Insert” on the menu bar. Then, click on “New Slide” on the “Insert” menu. Or, click on the “New Slide” tool on the tool bar. Choose a slide format to fit your desired content, and follow the prompts given.

Sometimes it’s easier to copy a slide, and then change the content of the slide than to create a new one. To copy a slide, click on the original slide. Click on “Edit” on the menu bar, and choose “Duplicate.” A new copy will be created to the right of the original slide. Or, click on “Edit” on your menu bar, and choose “Copy.”

You may then “Paste” the slide wherever you want it to appear.

To hide a slide from your presentation, but to keep it for future use, right click on the slide you wish to hide, and choose “Hide Slide” from the menu. Or, click on the “Hide Slide” tool on the tool bar.

To remove a slide from the presentation, click on the slide you want to remove. Click on “Edit” on the menu bar. Then, click on “Delete Slide” on the “Edit” menu. Or, click on the slide, and press the “Delete” key on your keyboard.

To change the order of the slides in the presentation, click on the slide to be moved and while holding the mouse button depressed, drag the slide to its new location. Release your mouse button to place the slide.

If you wish to change or remove the animation effect as you move from slide to slide:

Double click on the slide you want to change the animated transition on.

Double click on the text box of the slide. A border and white handles appear around the text box.

Click on “Slide Show” on the menu bar. Then, click on “Preset Animation.” To turn off the effect, choose “Off.” If you wish to change the effect, there are many options to consider.

To edit content of any slide:

Double click on the slide you want to change.

Double click on the text box of the slide. A border and white handles appear around the text Type the desired changes.

Remember to save any changes made to your presentation!
This leader’s guide is not intended as a substitute for first-hand knowledge of the applicable regulations. As a developer of high quality training materials, Coastal emphasizes the spirit and intent of applicable healthcare regulations and standards.

This guide is designed to provide accurate and authoritative information regarding the subject matter covered. Sources for this information are believed to be reliable. Because of the possibility of human error, the publisher does not guarantee its accuracy, adequacy or completeness. Coastal is not responsible for any errors, omissions, misprinting or ambiguities contained herein or for the results obtained from use of such information. If legal advice or other expert assistance is required, the services of a competent professional should be sought.

This leader’s guide is one of a series of print materials, video, interactive CD-ROM, Web-based and DVD programs produced by Coastal Training Technologies Corporation. Each product is the result of painstaking analysis, design, development and production by the instructional designers and technical specialists on our staff.

Our catalog is constantly being revised and expanded, so we would appreciate any comments on current titles or suggestions for future ones. For further information on any Coastal product, or to receive a free catalog, call Coastal Training Technologies Corp. (Virginia Beach, VA) at 800-729-4325 or send a FAX to 757-498-3657. Visit us on the Web at www.coastal.com.

This guide is for educational purposes only. Nothing herein is to be regarded as indicating approval or disapproval of any specific practice or product.

Copyright © 2006 Coastal Training Technologies Corp. Purchasers and renters may copy the Quiz found in the leader’s guide when they are used in conjunction with the program. Any other part of this product may not be copied by any means or for any reason without the written permission of Coastal Training Technologies Corporation. All Rights Reserved.

Created in U.S.A.

DIV016-ENG